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Lattice makes no warranty, representation, or guarantee regarding the accuracy of information contained in this document or the suitability of its
products for any particular purpose. All information herein is provided AS IS and with all faults, and all risk associated with such information is entirely
with Buyer. Buyer shall not rely on any data and performance specifications or parameters provided herein. Products sold by Lattice have been
subject to limited testing and it is the Buyer's responsibility to independently determine the suitability of any products and to test and verify the
same. No Lattice products should be used in conjunction with mission- or safety-critical or any other application in which the failure of Lattice’s
product could create a situation where personal injury, death, severe property or environmental damage may occur. The information provided in this
document is proprietary to Lattice Semiconductor, and Lattice reserves the right to make any changes to the information in this document or to any
products at any time without notice.
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Acronyms in This Document

A list of acronyms used in this document.

Acronym Definition

FPGA Field Programmable Logic Array
SEC Soft Error Correction

SED Soft Error Detection

SEI Soft Error Injection

SRAM Static Random Access Memory
PLD Programmable Logic Device

© 2018-2019 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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1. Introduction

An SRAM-based Programmable Logic Device (PLD) stores logic configuration data in SRAM cells. As the number and
density of SRAM cells in a PLD increase, the possibility of a memory error that alters the programmed logical behaviour
of the system also increases.

The Lattice Semiconductor MachXO3D™ devices have a hardware-implemented circuit called Soft Error Detection (SED)
which is used to detect SRAM errors and allows them to be corrected.

The MachX03D Soft Error Correction (SEC) is performed with background reconfiguration. All bits are rewritten during
reconfiguration and the erroneous bit is replaced with the correct data. During background reconfiguration, writing the
same value into configuration SRAM cells does not affect the SRAM cell output.

Soft Error Injection (SEI) is a feature of the Lattice Diamond® Programmer software. It is used to inject an error in the
MachX03D configuration SRAM.

This demo shows you all the SED, SEC, and SEI features of the MachX03D and how the development tool is used.

1.1. Demo Design Overview

This demo design consists of two major parts:
e  SED Hard Module — Performs read and error detection of SRAM content.

e  Control Logic — A state machine generating control signals for driving SED module. This includes soft error
indication and a function block that rotates the onboard LEDs.

The status of the demo is indicated by the onboard LEDs. The SEI bitstream is used to induce a single SRAM error into
the running demo. The SEI bitstream is generated using the SEI Editor available in the Tools tab of the Lattice Diamond®
software.

This demo covers the following operations:

e  Programming the board with the design

e Enabling SED

e Loading the SEI bitstream in the background and detecting the inserted error

e Background refreshing of the image after the error is detected by SED

www.latticesemi.com/legal
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1.2. MachX03D Development Board and Resources

Figure 1.1 shows the top side of the MachXO3D Development Board and resources used for the demo.
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Figure 1.1. MachXO3D Development Board

e JP11: Set to provide an external 12 MHz clock for the design.

e JP5: Auto SEC when being set.

e  SW1: A 4-bit DIP Switch; Up — 1; Down — 0; “110x” to enable SED.

e  SW2: Active low reset input for the design.

e  SW3: Starts SED for error detection.

e SWA4: Forces SED to generate an error output for testing when SW1 (Bit4-1) is set to “1101”.
e SW5: PROGRAMN when JP5 is set.

e JP8: Remove jumper from JP8.

e LEDO~7: LEDO~5 start to shift when the MachXO3D device is programmed with the design. LED6 (D3) is lighted
when an error is detected. LED7 (D6) blinking indicates the SED is enabled when SW1 (Bit4~1) is set to “1101”.
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2. Function Description

Figure 2.1 shows the block diagram of the demo design.

RESETn(SW2) ———»] PROGRAMN
SED
CLOCK —————— | JP5
SW3 ——p JL < »
RECFG SW5
SW4 ——————» )
Control Logic
DIPSW/[3:0] > e | ED7~0
MachX03D-9400HC

Figure 2.1. MachX03D Development Board SED/SEC Demo Block Diagram

3. Demo Package

3.1. Hardware Requirements

To run the demo, the following hardware are required:

e  PCrunning Windows 7 Operating System

e MachX03D Development Board

e  Mini USB cable for programming the MachXO3D device

3.2. Software Requirements

To run the demo, the following software are required:
e Lattice Diamond version 3.11 or later
e Lattice Diamond Programmer software for bitstream downloading

Note: The software programs are available at www.latticesemi.com/en/Products/DesignSoftwareAndIP.
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4. Port Assignments and Descriptions

Table 4.1 provides the port assignments and definitions in this demo.

Table 4.1. Design Port Definitions

Port Name 1/0 Type Description

RESETn Input Asynchronous reset. Active low (SW2).

CLK Input External 12 MHz clock input.

DIPSW([3:0] Input Up-1
Down -0
DIPSW[3] — Bottom
DIPSW[O0] — Top
DIPSW(3:0]="1101’ enables SED detection. LED7 (D6) starts blinking.

Sw3 Input Starts SED for a detection cycle.

Sw4 Input Forces SED to generate an error output and turns ON LED6 (D3) when DIPSW(3] is
Up(1).

RECFG Output For background SEC through reconfiguring the MachXO3D device after an error is
detected. Connected with PROGRAMnN and SW5, high impedance state after
configuration.

LED[5:0] Output Circulate lighting of LEDO~5 (D4, D8, D7, D1, D2, D5), indicates user logic is running.

LED6 Output D3. Indicates an error is detected by SED.

LED7 Output D6. When blinking, indicates the SED is enabled.
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5. Demo Package Directory Structure

Figure 5.1 shows the demo package directory structure.

=7 Mach¥03D_SED_SEC_deme

|_=_| | bitstream

.|~ impll_sei 0.bit

----- sed_sec_derno_impll.bit

- sed_sec_dermno_impll,jed

= docs

- MachX020_SED_SEC_Demeo_User_Guide.pdf

= hardware
=

|_:_| implementaticn
=) impll

..... impll sei

..... impll.xcf

----- sed_sec_demo_impll.bit

----- sed_sec_demo_impll.Ipf

- sed_sec_derno_impll_a.jed
----- sed_sec_demo.|df

----- sed_sec_demo.lpf

..... sed_sec_demo.sty
=} source

sed_sec_demo.w

Figure 5.1. Demo Package Directory Structure
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6. Running the Demo

6.1. Programming the MachXO3D Board with the Design
To load and run the SED/SEC demo design:

1. Before powering ON the board, make sure JP5 is set to 1.

2. Power ON the board by connecting it to the PC through the USB cable.

3. Launch the Diamond Programmer software (version 3.11 or later). In the Getting Started dialog box, select Create
a new project file from JTAG scan.

4. Click OK (Figure 6.1).

Diamond Programmer - Getti P i@i

Select an Action

@ Create a new project from a JTAG scan

Cable: [HW-USBN-28 (FTDT) | Port: [FTUSE-0 v ][ Detectcable

() Create a new blank project
(7) Open an existing programmer project

D:/flocal_work Project/Internal Reference_Design/XO3LF _9400C_RevB/SentryDevelopmentBoard_LCMXO3D-9400HC_SED_SEC_demo_0725/hardware implementation)impl 1fimpl 1. xcf

Figure 6.1. Launch Diamond Programmer

5. The LCMXO3D device is detected and displayed. Right-click on the device and select Device Properties... from the
right-click menu (Figure 6.2).

File Edit View Design Help

DEdlis 8 R &

Enable Status Device Vendor Device Family Device Device Ful Name Operation File Name |~ l
Cable Settings
| v D LCMX03D-9400HC  |LCMXO3D-9400HC | FLASH Erase, Program, Verify
:
{7l Device Properties... 3
Edit /O State... Bl cable: HW-USEN-28 (FTDI) - I
o
1 Copy Ctrl+C E Esrarms
5 \ e
Paste Ctrl+V 3 Programming Speed Settings
i Add Device @ Use default Clock Divider
ik Remove Device (&) Use custom Clock Divider
L Intemal Tools 3 i C TEK Divider Setting (0-30x%: [1 2
Output Info™ [
Lattice VM Drivers detected (HW-DLN-3C (Parallel), HV-USEN-2B (FTDI)) i) Message

INFO - Scanning USB2 Port FTUSE-0. .. -
Programmer device database loaded 3 2342002 INFO - Scanning USB2 Port FTUSB-0...

INFO - 5¢ leted fully. =
Can completed successtully. 3 2342003 INFO - Scan completed successfully.

Output Tel Consale Error Warning Info*

Figure 6.2. Open Device Properties Dialog Box

6. Set device properties as shown in Figure 6.3.
In the Device Properties dialog box, select Flash Programming Mode in Access mode, Flash Erase, Program, Verify
in Operation. In the Flash-A Programming Options area, select the bitstream file
\bitstream\sed_sec_demo_impll.jed from Programming file.

7. Click OK.

© 2018-2019 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
All other brand or product names are trademarks or registered trademarks of their respective holders. The specifications and information herein are subject to change without notice.
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id MachX03D - LCMX03D-8400HC - Device Properties ? X
General Device Information
Device Operation
Access mode: Flash Programming Mode -
Port Interface: JTAG Interface hd
Operation: FLASH Erase,Program, Verify hi

] Password Protection Options {(Provide key file if password protection enabled)

CFGO Programming Options

Programming file: 13D-3400HC_SED_SEC_demo_0725/bitstream/sed_sec_demo_impl1.jed | ...

D CFG1 Programming Cptions

Programming file:

Cancel

Figure 6.3. Set Device Properties

8. Click the Program button on the toolbar (Figure 6.4) to start programming.

File  Edit

Design  Help

IR YT IR B
Status Device Vendor  Device Family Device Device Full Name Operation File Name File Date/Time = l
Cable Settings
| 1 Lattice MachX03D LCMX03D-9400HC LCMXO03D-9400HC  FLASH Erase Program, Verify ..o_0725/bitstream/sed_sec_demo_impl1.jed 09/27/1816:39:32

Cable: HW-USBN-25 (FTDI) - I
Port: FTUSE-0 =

Custom port:

Programming Speed Settings

Cable and IfO Settings

@ Use default Clock Divider

(@) Use custom Clock Divider

d U | G TCK Divider Setting (0-30x): |1
output Info™ a %
Lattice VM Drivers detected (HW-DLN-3C (Parallel), HW-USBN-2B (FTDI)) D Message
INFO - Scanning USB2 Port FTUSB-0... .
Programmer device databsse Iosded W& 2342002 INFO - Scanning USB2 Port FTUSB-0...
INFO - S leted fully. o
€3N Compisted sdccessTUly. 5 2342003 INFO - Scan completed successfully.

Output Td Console Error Warning Info™

Figure 6.4. Start Programming Operation

If the programming is completed successfully, “Operation: successful” is reported in the Output panel. LEDs are
circulated lightening one after another.

© 2018-2019 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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6.2. Enabling SED
To enable SED:
1. Make sure JP11 is set to provide the external 12 MHz clock for the design.
2. Set SW1 (DIPSWI3:0]) all bits up.
3. Push down SW1 BIT2 (DIPSW[1]) to enable SED. LED7 (D6) starts to blink. This indicates that SED is enabled.
4. Force SED to generate an error.
a. Set SW1-BIT1 DIPSW[0] up.
b. Press SW4 to generate the error.
LED6 (D3) turns ON. This indicates that an error is generated.

LEDO
LED1
LED2
LED3
LED4
¥ LEDS
LEDS
LED7

sSwa

©
>
(7]
T
@
m
b
]
=<
o
—
g
m
(2]
3

SW1 - Bit1 DIPSW[0]
SW1 - Bit2 DIPSW[1]
SW1 - Bit3 DIPSW[2]
SW1 - Bit4 DIPSWI[3]

!IIIHHHHIHIHHIIL

Figure 6.5. Press SW4 to Force SED to Generate Error

5. Press SW3 to start the SED detection cycle. LED6 (D3) turns OFF. This indicates that no error is injected/detected.
See the Loading SEI Bitstream in Background and Detecting Inserted Error section for error injection and detection.

6.3. Loading SEI Bitstream in Background and Detecting Inserted Error
To insert an error in the SRAM array:

1. Launch the Diamond Programmer software (version 3.11 or later). In the Getting Started dialog box, select Create
a new project file from JTAG scan.

2. Click OK (Figure 6.6).

_ ,

Select an Action

@ Create a new project from a JTAG scan

Cable: [HWAUSEN-28 FTDT) v | port: [FTUSE-0 | [ Detectcable

() Create a new blank project
) Open an existing programmer project

D: flocal_work/Project/Internal Reference_Design/X03LF_3400C_RevB/SentryDevelopmentBoard_LCMX03D-9400HC_SED_SEC_demo_0725/hardware implementation/impl 1impl 1.xcf

d

Figure 6.6. Launch Diamond Programmer

3. The LCMXO03D device is detected and displayed. Right-click on the device and select Device Properties... from the
right-click menu (Figure 6.7).

© 2018-2019 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal
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File Edit View Design Help

=)= B e E

Enable Status Device Vendor Device Family Device Device Full Name Operation File Name File Date, |~ l
Cable Settings
| 1V - MachX03D LCMX03D-9400HC | LCMX03D-9400HC | FLASH Erase, Program, Verify @ D B "

Edit I/O State...

=3 Cable: HW-USBN-28 (FTDI) -
Custom Devices... ] |
& Port: FTUSE-0 -
ﬁ Copy Ctrl+C g
- g Custom port:
Paste Ctrl+V 5
o
a|  Programming Speed Scttings
3 Add Device 3 ceraming Se N

(@ Use default Clock Divider

{4 Remove Device
(2 Use custom Clock Divider

Internal Tools 3

< n C TCK Divider Setfing (0-30x%: [1 =
Output Info® o x
Lattice VM Drivers detected (HW-DLN-3C (Parallel), HW-USBN-28 (FTDI)) 0} Message
Programmer device database loaded
INFO - Scanning USB2 Port FTUSB-0. . &) 2342002 INFO - Scanning USE2 Port FTUSB-0...
INFO - S leted Fully. =

3N CompIEted successTUy &) 2342003 INFO - Scan completed successfully.

Output Tel Consale Error Warning Info*

Figure 6.7. Select the Device

4. Set device properties as shown in Figure 6.8.
In the Device Properties dialog box, select Static RAM Cell Background Mode from Access mode, XSRAM SEI Fast

Program in Operation. In the Programming Options area, browse to select the SEl bitstream file
\bitstream\impl1_sei_0.bit in Programming file.

5. Click OK.
44 MachX03D - LCMX03D-3400HC - Device Properties 7 *
General Device Information

Device Operation

Access mode: Static RAM Cell Background Mode -
Port Interface: ITAG Interface -
Operation: XSRAM SEI Fast Program -

Programming Options

Programming file: L_demoﬂ.cMKDSD—Q‘&UUHC_SED_SEC_demo_o?zsfbitstreamﬂmpl1_sei_0.bitl | -

[] Password Protection Options (Provide key file if password protection enabled)

Cance

Figure 6.8. Set MachXO3D Device Properties

6. Click the Program button on the toolbar (Figure 6.9) to initiate background programming.

© 2018-2019 Lattice Semiconductor Corp. All Lattice trademarks, registered trademarks, patents, and disclaimers are as listed at www.latticesemi.com/legal.
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" Diamond Program

File Edit View Design Help

I Y 1

Enable Status Device Vendor Device Family Device Device Ful Name Operation File Name File Date, ‘n
I Cable Settings
i -WM LCMX03D-9400HC | LCMX03D-9400HC | XSRAM SEI Fast Program ..D_SEC_demo_0725bitstream/impl 1_sei_0.bit 09/27/18 16:43]

Detect Cable =

Cable: HW-USBN-28 (FTDI) - I
Port: FTUS8-0 -

Custom port:

Cable and I/O Settings

Programming Speed Settings
@ Use default Clock Divider

(7 Use custom Clock Divider

gl n b TCK Divider Setting (0-30x); |1

&
b3

Output Info*

Lattice VM Drivers detected (HW-DLN-3C (Paraliel), HW-USEN-28 (FTDL)) 1D Message

Programmer device database loaded -
INFO - Scanning USB2 Port FTUSB-0... W32 2342002 INFQ - Scanning USB2 Port FTUSE-0...

INFO - S leted fully. =
can completed successfuly. L) 2342003 INFO - Scan completed successfully

OQutput Tel Console Error Warning Info*

Figure 6.9. Start XSRAM SEI Fast Program Operation

Remove jumper from JP5.
With JP5 jumper removed, press SW3 again. When SW3 is pressed, LED6 (D3) turns OFF. If LED6 (D3) turns ON
when SW3 is released, this indicates an error exists and SEC is not working.

9. SetJP5 and press SW3 again. LED6 (D3) does not turn ON after pressing SW3 a second time. This indicates that
SEC is already working at the background by driving PROGRAMN low based on the design.

SW3

. 3 =
o sl B =
[ s
c30
s

HOL1D3NNOD Id ANN3adsvy

SW1 - Bit1 DIPSW[0]
SW1 - Bit2 DIPSW[1]
SW1 - Bit3 DIPSW[2]
SW1 - Bit4 DIPSW[3]

Figure 6.10. Press SW3 to Start SED for the Injected Error

6.4. Background Refreshing the Image after Soft Error Detection

There are several ways to reload the design bitstream at the background. The MachX03D device supports the following

methods of refreshing the SRAM array and correcting detected soft errors.

e  Providing the original bitstream at the background through an external sysConfig™ slave port. For example, this
can be done through JTAG or by using I1>°C/SPI embedded programming technique.

e Transferring the original bitstream from internal or external Flash memory, initiate through sysConfig REFRESH
command.

e Transferring the original bitstream from internal or external Flash memory, initiate through external PROGRAMN
pin assertion. This is demonstrated in steps 8 and 9 of the Loading SEI Bitstream in Background and Detecting
Inserted Error section.
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6.4.1. Providing the Original Bitstream in the Background

Refreshing the SRAM array with the original bitstream through the JTAG port is similar to loading the SEI bit file in the
Loading SEI Bitstream in Background and Detecting Inserted Error section. The only difference is the bitstream to be
used for loading.

To provide the original bitstream in the background:

1. Make sure JP5 is removed and repeat the appropriate steps in the Loading SEI Bitstream in Background and
Detecting Inserted Error section to inject error again.

2. Inthe Device Properties dialog box, browse to select the design bitstream file \bitstream\
sed_sec_demo_impl1l.bit from Programming file in the Programming Options area.

3.  Click OK (Figure 6.11).

1. MachX03D - LCMX03D-9400HC - Device Properties ? X

General Device Information

Device Operation

Access mode: Static RAM Cell Background Mode -
Port Interface: ITAG Interface -
Operation: X5R.AM SEI Fast Program -

Programming Options

Programming file: IZMXO30—940DHC_SED_SEC_demo_[l?}lSJ'bitst'eam,.’sed_sec_demo_impll.bit

[] password Protection Options (Provide key file if password protection enabled)

Cancel

Figure 6.11. Reload Design Bitstream in Background through JTAG

4.  Click the Program button on the toolbar, as shown in Figure 6.12, to initiate background programming of the
device. The original design bitstream is loaded after the software reports “Operation: successful”.

4.} Diamend Programmer - Untitled * =TI
File Edit View Design Help
IR Y IR
Ensble Ststus DeviceVendor  Device Famiy Device Device Full Name Operation File Mame =
Cable Settings
MachX03D LCMXO3D-9400HC |LCMXO3D-9400HC | XSRAM SHI Fast Program ..5EC_demo_0725/bitstream/sed_sec_demo_impl 1.bit
=}
E Custom port:
=
4| Programming Speed Settings
3
@ Use default Clock Divider
(©) Use custom Clock Divider
<l ), D TCK Divider Setfing (0-30x1: [1 Z
Output Info* a x
INFO - Device 1 LEMXO3D-3400HC: ¥SRAM SEI Fast Program : o Message T
1) 2342002 INFO - Scanning USB2 Port FTUSE-0... .
INFQ - Operation Done. Mo errors. =
3 2342003 INFO - Scan completed successfully.
INFO - Elapsed tme: 00 min : 02 sec
i \i) 85021074 INFO - Check configuration setup: Start.
INFO - Operation: successful. E
=i 5 85021078 INFO - JTAG Chain Verification. Ne Errors, -
Output Td Consale Error Warning Info™
Ready
L

Figure 6.12. Reload Design Bitstream in Background through JTAG

5.  Press SW3 to start the SED. LED6 (D3) turning OFF indicates that the injected error is corrected by background
reconfiguration.
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6.4.2. Transferring Original Bitstream Using REFRESH

Reloading the design bitstream at the background refreshes the SRAM array from the internal flash using the REFRESH
command.

To load the original design bitstream from internal flash:

1. Make sure JP5 jumper is removed and repeat the appropriate steps in the Loading SEI Bitstream in Background
and Detecting Inserted Error section to inject the error again.

2. Inthe Device Properties dialog box, select Static RAM Cell Background Mode from Access mode, XSRAM Refresh
in Operation, as shown in Figure 6.13.

3. Click OK after the command is set.

F ™
{.} MachX03D - LCMXO3D-9400HC - Device Properties A=

General Device Information |

Device Operation

Access mode: [51311':: RAM Cell Background Mode - ]
Port Interface: [JTAG Interface A ]
Operation: [XSRAM Refresh A ]

Figure 6.13. Use XSRAM Refresh

4.  Click the Program button on the toolbar, as shown in Figure 6.14 to initiate background programming of the
device. The original design bitstream is loaded after the software reports “Operation: successful” while the logic is
working.

4.} Diamond Programmer - Untitled * ; [E=ER =5

File Edit View Design Help
EECIIEEY Y I 6

Enable Status Device Vendor Device Family Device Device Full Name Operation File Name

Cable Settings
MachX03D LCMXO3D-9400HC |LCMX03D-9400HC | XSRAM Refresh

Cable: HW-USBN-28 (FTDI) -
Port: FTUSE-0 -

Custom port:

Programming Speed Settings

Cable and 1/0 Settings

@ Use default Clock Divider
() Use custom Clock Divider

al 0 D TCK Divider Setting (0-30:0: [1 &
Output Info* 8 x
- D Message B
INFO - Devicel LCMXO3D-5400HC: XSRAM SEI Fast Program ~ T
i) 2342002 INFO - Scanning USB2 Port FTUSB-0... B
INFO - Operation Done. No errors. =
5 2342003 INFO - Scan completed successfully.
INFO - Elapsed tme: 00 min : 02 sec ;
\i) 85021074 INFO - Check configuration setup: Start.
INFO - Operation: successful. Ml
~|| 3 8021076 INFO - JTAG Chain Verification. No Errars. o
Qutput Tel Console Error Warning Info*

Figure 6.14. Start XSRAM Refresh Programming Operation

5.  Press SW3 to start the SED. LED6 (D3) is not turned ON. This means the injected error is corrected by background
refresh.
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6.4.3. Transferring Original Bitstream Using External PROGRAMN Pin Assertion
To transfer the original bitstream from internal or external Flash memory by asserting external PROGRAMN pin:

1. SetJP5 by adding jumper on, as shown in Figure 6.15.

oEEnes MM U

SEMICONDUCTORm
MachXO3D Developement Board
REV A
P/N:LCMXO3D-9400HC-D-EVN
Copyright © 2018

Made in USA

asroas g
RHRRIR | e2fee
seee

2
85 oi°
0 ON
€93

sw3
sw2
»5
swa
SW3 ST : : , : 2 2s LCMX03D-9400HC
| ( 3 0 . 4

1
o) (I

<
nv»uwuumum"

e "
U4 L a3
CROSSLINK RX1 CROSSLINK RX2 AARDVARK

Figure 6.15. Auto Background Reconfiguration

2.  After SEl operation is completed, as described in the Loading SEI Bitstream in Background and Detecting Inserted
Error section, press SW3 to start SED. LED6 (D3) turns ON. This indicates that the error is injected. At the same
time, the design drives PROGRAMN low if JP5 is set to reconfigure the device in the background while the logic is
still working.

3. Press SW3 again to restart SED and detect no error. The LED6 (D3) is not turned ON. This indicates that the
injected error is corrected by the background reconfiguration.
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7. Rebuilding the Design

To rebuild the design:

1. Start the Diamond software. In the Navigator window, click Open under Project. Open the Lattice design file (*.Idf)
located in the ./hardware/implementation folder.

File Edit View Project Design Process Tools Window Help

PrE-HdBiraycn GRS

BES e EHEGES
-

EEEE
FEEEE:S

X
o
ri
g
£
i
m

x|

Project: o
1% Open.
BEnew...

[ Import ispLEVER Progect...

i

Recent Projects:
[ sed_sec_demo

(3 MachX03D_Hitless_I0_demo

(3 MachXO3LF Hitless_IO_demo
[ sed_sec_demo

1] MachX03IF_Hitiess T0_dems

Software Update Center

Currently running Lattice Diamond software version:
3110.247.0

No updates avalable

Last check time: Fri Sep 28 13:13:01 2018

Fielist | Process | Hierarchy

Output 8 X Td Console & X

> por_project open "D:/local_werk/Project/Internal/Reference_Design/XO3LF_8400C_RevB/SentryDevelopmentBoard LCMKOSD-9400HC_SED_SEC_ ~
XCF file opened successfully.

> pgr_program run
pgr_progran run completed successfully.

> pri_run Export -impl impll -task Jedecgen
> pri_run Export -impl impll -task Bitgen
> pri_run Export -impl impll -task Jedecgen
> pgr_project close

> pri_project close

> L4

i

Output | Ermor | Waning | Info | FindResuits < i '
|| Open Existing Project Mem Usage: 171,664 K

Figure 7.1. Open Design File

2.  The opened project is shown in Figure 7.2.

Fle Edit View Project Design Process Tools Window Help
H-w-E B | el R AQA | B CEED
ek pa——ey = nn =
CRESESCHEGA=sUS<AR>” REFNEE
File List & || {F StartPage Reports [ & x|
4 {7 sed sec_demo; impl1 &) 52
1L LCMX03D-9400HC-6BG484C =
4 [} Sustegies Design Summary
Eb Ares 4 7 project
[ 10 Assistant 9 Project Summsry Module Name: sed_sec demo Synthesis: Lattice LSE
[ Quick 4 =0 Process Reports i
B Timing . ) Lattice LSE Irplemencation |impll Strategy lHame: Stratagyl
2™ Nare:
trategyl > p =
4 [IH impi1 > @) Place & Route Last Process: State:
4 | Input Files g % Signal/Pad | |Targec Device: |LoMx03D-3400HC-GBG4B4C Device Family: MachX03D
4 Bitstream/JEDEC E
¥ -/source/sed sec_demo.v 4 B Analysis Rs Device Type: LOMEO3D-9400HC Package Type: CABGR4EE
Synthesis Constraint Files T Analysis Reports
4 3} LPF Constrint Files . ®) LSE Timing Report Performance 5 Operating conditiona: con
[y sed_sec_demo.lpf [M) Map Trace TEite
Debug Files [ Place & Route Trace Togic sed_sec_demo.1pt
Script Files [ Thermal Analysis preference
Analysis Files [1] /0 Timing Analysis e
a Programming Files 4 = Tool Reports | || |enysical impll/sed_sec_demo_impll.prf
[ implL/implLxck [™ V0 550 Analysis Preference
¥ Hierarchy Parsing Report file:
[ P10 DRC Product 3.11.0.247.0 Patch Version:
> ¥ TCL Command Log .| |version: i
FieList | Process | Hierarchy—Post Map Resources =
output B x| Td Consoe & x
compiling module sed sec_demo ][> por_progran run B
mEo - PUr_program run corpleted successfully
D:/local_work/Froject/Internal/Reference Design/XO3LE_9400C RevB/SentryDevelopmentdoard || > prj_run Eaport -impl impll -task Jedecgen
_LOMX03D-34008C_SED SEC_demo_0725/hardware/source/sed_sec_demo.v(1,1-135,10) > pri_run Export -impl impll -task Bitgen
(VERI-9000) elzborating module 'sed sec_demo' > pri_run Export -impl impll -task Jedecgen
ES - > por_project close
C:/lsce/diamond/3.11_x64/ispfpge/uservare/NT/SYNTHESTS HEADERS/machxo3d.v(1562,1-1569,1 | | > pri_project close
0) (VERI-9000) elaborating module 'SEDFA_unig 1' =|| > pra_project open "Di/local_werk/Broject/Internal/Reference Design/X03LE_9400C_Reve/SentryDevelopmentBoard LCMXO3D-2400HC_SED SEC |=
Done: design load finished with (0) erzors, and () warnings D:/1ocal_work/Project/Internal/Reference_Design/X0SLE_9400C_RevB/SentryDevelopmentBoard LCMKOSD-9400HC_SED_SEC_dems_0725/hardware
/izplenentation/sed_sec_demo.lds
=i -
ouput | Emor | Waning | Info* | FindResuts < i '
Ready Mem Usage: 172,004 K

Figure 7.2. Project Opened

3. Synthesize the design to make sure there is no error. Refer to the user guide of Lattice Diamond software for
details on how to perform this process.
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4. When you see a green check mark beside the Synthesize Design process in the Process view, choose Tools >
Spreadsheet View or click the Spreadsheet View icon & on the toolbar to open the Spreadsheet View. In the
Global Preferences tab, set SDM_PORT to PROGRAMN and BACKGROUND_RECONFIG to ON, as shown in
Figure 7.3.

File Edit View Project Design Process Jools Window Help
N-E-Ha 8| gnh;:e AR qa|EE:E )
YEOCHBRERN S UEEQGAUYscBR” MEFNEE'G

Process 8 % | {f StartPage | [ Reports [ | 5 Spreadshect View [ | Gl "I

‘ "f""‘f“}’egas‘f‘” . & | Preference vame Preference Value -
% Lattice Synthesis Engine ‘s
“ “-SHF‘ADE“B” L) SDM_PORT. PROGRAN
2 Map Trace 5P
[] 2 Verilog Simulation File 12C_PORT DISABLE -
[7] 2 VHDL Simulation File WASTER_SPI_PORT DISABLE
+ % Plce uRouts Deign | coeREss oneis o
[[] 2 Place & Route Trace 2 WY _ASSP OFF
[0 & 1O Timing Analysis & CONFIG_SECURE OFF 3
[] ¥ Thermal Analysis WCCLK_FREQ 208
4 2 BportFiles K JTAG_PORT ENABLE
2 S Model - ENABLE_TRANSFR DISABLE
et SHAREDEBRINIT DISABLE
[£] ¢ Verilog Simulation File = Y CON RATION POR DISAB ||
[C) 2 VHDL Simulation File » BACKGROUND_RECONFIG ON
2 Bitstream File BACKGROUND_RECON ORI 0
%{ JEDEC File 2 SPIN_ADDRESS_32BIT DISABLE
2 BULK_ERASE
% SFDP_CHECK DISABLE
o PRIMARY_BOOT IMAGE_0
: SECONDARY_BOOT NONE
SLAVE_IDLE_TIMER 0
= WASTER_PREANBLE_DETECTION_TIMER 0 o
Flelist | Process | Herarchy—Post Map Resources Port Assignments | Pin Assignments | Clock Resource | Route Priority | Cell Mapping | Giobal Preferences | Timing Preferences | Group | Misc Preferences

lOutput & x| Td Console & x
Design name: sed_sec_demo 4 |[> pri_run Export -impl impll -task Bitgen -forcedne
NCD version: 3.3 > prj_run Export -impl impll -task Jedecgen -forceRll
‘Vendor: LATTICE > pgr_project close
Device: LCMX03D-9400HC > prj_project close
Package: CABGAdE4 > pri_project cpen "D:/local_work/Project/Internal/Reference_Design/X03LE_400C_RevB/SentryDevelopmentBoard LCMXO3D-9400HC_SED_SEC_
Performance: 6 D:/local_vwork/Froject/Internal/Reference_Design/XC3LE_8400C_RevE/SentryDevelepmentBoard LCMXO3D-9400HC_SED_SEC_demo_0725/hardware | —
Package Status: Advanced Version 10. /implementation/sed_sec_demo.ldf
Performance Hardware Data Status: Version 0.0. > prj_run Export -impl impll -ta Jedecgen -forceRll E
Finish leading physical design information > pri_run Export -impl impll -task Bitgen -forceOne T
INFO - There is no custem column infermation ‘7‘ > prj_run Export -impl impll -task Jedecgen -forceRll

I L
Cutput | Eror | Warning® | Info™ | FindResults ] I v
Ready Mem Usage: 234,200 K

Figure 7.3. Set Global Preferences

Click File > Save to save your settings.

In the Process view, under the Export Files process, select the Bitstream File and JEDEC File checkboxes, as shown
in Figure 7.4.

Double click the Export Files process.

From the menu bar, select Process > Rerun All to run the entire process. The bitstream file and the JEDEC file are
generated.
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File Edit View Project Design | Process| Tools Window Help
A-@--d [E] Run R_|aqAQ ] =]
Rerun Y oy nn
e se@s> MEH @
erun = — -
Frocess % | &7 stertrage [ | | spreadsheetview 0 | =[x
4 N Synthesize Design 0 st o | Preference Name Preference Value -
% Lattice Synthesis Engine 4+ sysConfig
P Clean Up Process
“N MHE_DE”!” = B nn SDM_PORT PROGRAMN
[ 2 Map Trace SLAVE_SPI_PORT DISABLE
[7] 2 Verilog Simulation File 12C_PORT DISABLE
[ 2% VHDL Simulstion File WASTER_SPI_PORT DISABLE
4 % Ploce & Route Design COMPRESS_CONFIG oN
CONFIGURATION cFa
[[] & Place & Route Trace WY _ASSP OFF
[7] 2 1O Timing Analysis CONFIG_SECURE OFF 3
N WCCLK_FREQ 208
JTAG_PORT ENABLE
ENABLE_TRANSFR DISABLE
SHAREDEBRINIT DISABLE L4
erilog Simulation File MUX_CONFIGURATION_PORTS DISABLE
Rl Simulation File BACKGROUND_RECONFIG oN
2 Bitstream BACKGROUND_RECONFIG_SECURITY  OFF
2/ JEDEC Fils 5 SPIM_ADDRESS_32BIT DISABLE
= BULK_ERASE YES
% SFDP_CHECK DISABLE
PRIMARY_BOOT IMAGE_0
SECONDARY_BOOT NONE
SLAVE_IDLE_TIMER 0
WASTER_PREAMBLE_DETECTION_TIMER 0 -
Flelist | Process | Hierarchy—Post Map Resources Port Assignments | Pin Assignments | ClockResource | RoutePriority | CellMapping | Global Preferences | TimingPreferences | Group | MiscPreferences
loutput & x| Td Console 8 x
Design neme: sed_sec_demo »|[> pri_run Export -impl impll -task Bitgen —forcelne -
. > pri_run Export -impl impll -task Jedecgen -forceAll
LATTICE > pgr_project close
LCMKO3D-9400HC > pri_project close
CRBGR4E4 > prj_project open "D:/local_work/Project/Internal/Reference_Design/XO3LF_9400C_ RevB/SentryDevelopmentBoard LCMXO3D-3400HC_SED_SEC_
16 D:/local work/Project/Internal/Reference Design/KG3LE_9400C RevB/SentryDevelopmentBoard LCMX03D-9400HC_SED SEC demo_0725/hardware [ —
Package Status: Adwanced Version 10. /implementation/sed_sec_demo.1d:
Performance Hardware Data Status: Version 0.0. > pri_run Export -impl impll -task Jedecgen -forceAll .
Finish loading physical design information > pri_run Export -impl impll -task Bitgen -forceOne 3
INFO - There is no custom column information > pri_run Export -impl impll -task Jedecgen -forceAll
> L3
Output | Emor | Wamning® | Info* | FindResults < i >
Ready Mem Usage: 230,572 K

Figure 7.4. Generate the Bitstream

The SEI bitstream for error injection can be generated using the SEI Editor tool, as shown in Figure 7.5.

File Edit View Project Design Process [Jools | Window Help
PrBrH g e /g [1|# Spreadsheet View
; , oo Package View
*ECEAEEEESELD
o evice View .
2 % Symtheine B Netlist Analyzer
N Synthesize Design ce Name Preference Value
% Lattice Synthesis Engine B Netist View onfig
« MEE_DES‘QH R Ry DM_PORT PROGRAMN
[ 2 Map Trace Pa. LAVE_SPI_PORT DISABLE
] 2 Verilog Simulation File B Pepres 2C_PORT DISABLE -
pes IASTER_SPI_PORT DISABLE
2 £ 2 VHDL Simultion File 5, RevealInserter “OMPRESS_CONFIG oN
4 % Place & Route Design -
ONFIGURATION CFG
=] :“: Place & Route Trace 2 | PR v_AssP OFF
[[] 2 VO Timing Analysis = ONFIG_SECURE OFF
[7] 2 Thermal Analysis CCLK_FREQ 2.08
4 [ Export Files B Physical View TAG_PORT ENABLE
7] 2 1815 Model NABLE_TRANSFR DISABLE
py @ Timing Analysis View HAREDEBRINIT DISABLE 4
[T 3 Verilog Simulation File §@ Power Calculator UX_CONFIGURATION_PORTS DISABLE
[C] 2 VHDL Simulation File = ACKGROUND_RECONFIG ON
2 Bitstream File & | ECOEditor ACKGROUND_RECONFIG_SECURITY  OFF
JEDEC File 4 Programmer E\FK,A;)RDA%ESSJQB\T ‘E\ESSAEILE
& seEditor FDP_CHECK DISABLE
RIMARY_BOOT IMAGE_0
S Synplify Pro for Lattice ECONDARY_BOOT NONE
LAVE_IDLE_TIMER 0
B Active-HDL Lattice Edition IASTER_PREAMBLE_DETECTION_TIMER 0 o
FleList | Process | Hirarchy—Post Map Resour| &3 Run Manager gnments | Pin Assignments | ClockResource | RoutePriority | CelMapping | Gobal Preferences | TmingPreferences | Group | Misc Preferences
Output "j" SrndzEim A & X Td Console F x
Design name: sed_sec_demo Clear Tool Memory «|[> pri_run Export -impl impll —task Bitgen -forceOne -
WCD version: 3.3 > prj_run Export -impl impll -task Jedecgen -forceAll
Vendor: LATTICE Qptions > pgr_project close
Deviee: LCMXO3D-9400HC - > prj_project close
Package: CRBGR4E4 > prj_project open "D:/local_work/Project/Internal/Reference Design/XO3LF_8400C_RevB/SentryDevelopmentBoard LCMEO3D-9400HC_SED SEC_
Performance: & D:/lecal_work/Project/Internal/Reference Design/XO3LE_9400C_RevB/SentryDevelopmentBoard LCMKO3D-9400HC_SED SEC demo 0725/hardware [ —
Package Status: Advanced Version 10. /implementaticn/sed_sec_demo.ldf
Performance Hardware Data Status: Version 0.0. > pri_run Export -impl impll -task Jedecgen -forceAll L
Finish loading physical design information > pri_run Export -impl impll -task Bitgen -forceOne r
INFO - There is no custom column information > pri_run Export -impl impll -task Jedecgen -forceAll
> 4
output | Error | Wamning® | Info= | Find Results < i '
SEl Editor Mem Usage: 231,416 K

Figure 7.5. Generate the SEI Bitstream

The rebuilt design can be programmed in the MachXO3D device, as described in the Running the Demo section.
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Technical Support

For assistance, submit a technical support case at www.latticesemi.com/techsupport.
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